
iPad Meeting 

  

This is a summary of the iPad meeting on Tuesday May 7,2013.  

The medical apps I discusses were: 

WebMD, iTriage, UMSkinCheck, Cancer.net, EyeChart, Durgs.com, Shoulder 

(search Orca), Healthspek, Vitals, My Medical For iPad, and Remind Me 

Prescriptions. 

The other two I discussed were Full Deck Solitare and AppsGonFree. 
  

Paul Rabenold discussed non apps – Google for more information on the following - 

iTunes, Tunes Match, and Copy Trans. 
  

John Campbell discussed the following apps - YouTube, My Tube, Winp, Golf 

Academy, and TeamViewer. 
  

If you have any apps you like, send them to me so I can share them. 
  

If you have any questions, let me know, 

Art Fenn 

430-0252  
************************************************************************* 

Click here: Skype for Windows 8 Announced  

**************************************************************************** 
 
 
Folder Icons or Details XP & Win 7 
  
Rightclick START and click Windows Explore. 
  
If you prefer to see pictures (icons) that represent the subfolders stored in a folder, then you would want 
to click VIEW and select ICONS. 

 
 
 
If you prefer to know more about each folder, then click VIEW and select DETAILS.  On the menu bar you 
will see a little block that has what appears to be tiny icons on it sitting on the menu bar. Click that little 
block and you'll get the same choices as when clicking VIEW.  There are also other choices such as 
thumbnails, that's icons with a frame.  Or you may select List which is just a list of folders and Files with 
no other info. 
 



Note: Win 7 The tiny VIEW icon is at the right end of the menu bar. Click it and then click the down arrow 
to select your preference. 
**************************************************************************************************** 

Getting Help with Windows 7 

The Windows Help and Support contains answers to most 
questions you have about Win 7.  Use it. Below is an example of 
information about Libraries. Check it out now before you're in a 

situation where you need an answer ASAP. 

1. Click Start and click Help and Support. 

2. In the search box type LIBRARIES.  Click ENTER. 

A list is presented related to Libraries. 

Learn by clicking one topic at a time and carefully reading it. For 

instance, 

What is a library? 

In some ways, a library is similar to a folder. For example, when you open 
a library, you'll see one or more files. However, unlike a folder, a library 

gathers files that are stored in several locations. This is a subtle, but 

important, difference. Libraries don't actually store your items. They 
monitor folders that contain your items, and let you access and arrange the 
items in different ways. For instance, if you have music files in folders on 
your hard disk and on an external drive, you can access all of your music 
files at once using the Music library. 

How do I create or change a library? 

Windows has four default libraries: Documents, Music, Pictures, and Videos.  

To create a new library 

Click the Start button, click your user name (which opens your personal folder), and 

then, in the left pane, click Libraries. 

1. In Libraries, on the toolbar, click New library. 

2. Type a name for the library, and then press Enter. 

To change a library 



Include or remove a folder. 

Change the default save location 

Change the type of file a library is optimized for 

 

What happens if I delete a library or the items in a library? 

If you delete a library, the library itself is moved to the Recycle Bin. The 
files and folders that were accessible in the library are stored elsewhere 
and therefore aren't deleted. If you accidentally delete one of the four 
default libraries (Documents, Music, Pictures, or Videos), you can restore it 
to its original state in the navigation pane by right-clicking Libraries and then 

clicking Restore default libraries. 

If you delete files or folders from within a library, they are also deleted 
from their original locations. If you want to remove an item from a library 
but not delete it from the location it's stored in, you should remove the 
folder containing the item. For more information, see Include folders in a 

library. 

Similarly, if you include a folder in a library and then delete the folder from 
its original location, the folder is no longer accessible in the library. 

Why can't I search or arrange files from a folder that I recently included in a 

library? 

If a folder from a non-indexed location (such as an external hard drive or a 
network) was recently included in a library and it contains a large number 
of files, it might take some time for the library to add those files to the 
index. During the indexing process, searches and file arrangements might 

appear incomplete. For more information about indexing, see Improve 

Windows searches using the index: frequently asked questions. 

What types of locations are supported in libraries? 

You can include folders in a library from many different locations, such as 

your computer's C drive, an external hard drive, or a network. 



3.  On the Windows Help and Support tool bar click the Browse 
Help icon(looks like a book). The contents of the HELP file appears, 
organized by category. 

4. Click Files, Folders and Libraries.  The topics in that category are 
listed along with subcategories. 

5. Click the Working with Libraries topic.  The topic is displayed. 

Note: Clicking a green word or phrase displays it's definition. Click away 
from the definition box to close it. 

6. Read the topic.  Click  BACK one or more tims to return to Files, 
Folders and Libraries category. 

7.Click the Creating, opening and saving category, and then click the 
SAVE A File topic. The title of each of the topic's subtopics is shown in bold 
text and preceded by an arrow. 

8. At the top of the topic, click SHOW ALL. The two subtopics expand 
to display hidden information.  You can PRINT the displayed topic by 
clicking the PRINT button on the toolbar. Subtopics will be printed only if 
they are displayed. 

9. On the toolbar click ASK.  Other ways to get help will be displayed. 

10. Click the X on the tool bar to CLOSE. 

If your question is about Win 7 and you can't find the answer here, search 
on Microsoft's Knowledge Base at www.support.microsoft.com  or at 
www.support.microsoft.com/gp/selfoverview/ 

******************************************************************************

***************************************** 
 

Libraries,  Folders and Files in Win 7 
  

 

You can access your files and folders and organize them in different ways. 
  



The Documents Library - Here organize your wordprocessing documents, spreadsheets, 

presentations and other text related files.  By default text related documents that are 

moved, copied or stored  are stored in the  My Documents Folder. 
  

The Pictures Library - Here organize your pictures whether from you camera, scanner or 

email. By default files that you move, copy or save to the Pictures Library is stored in the 

My Pictures Folder. 
  

Music Library - Organize and arrange your digital music such as those downloaded from 

the internet, copied from a CD or sent to you attached to an email.  By default files that you 

move, copy or save to the Music Library are stored in the My Music Folder. 
  

Videos Library  - Organize and arrange video clips from your camera, your camcorder or 

that you downloaded from the internet.  By default, files that you move, copy or save to the 

Videos Library are stored in the My Video Library. 
  

******************************************** 

Create a new Library in Win 7 
  

1. Click the START button, click user name, and click libraries in the left pane. 

2. In Libraries, on the toolbar, click New library. 

3. Type a name for the new library and press Enter. 
  

**************************************************** 

Remove a folder from a library in Win 7 
  

1. On the taskbar, click Windows Explorer button. 

2. In the left pane (navigation pane) click the library that you want to remove folders from. 

3. In the library pane (above the file list), next to Includes, click Locations. 

4. In the box that appears, click the folder you want to remove, click Remove and click OK. 

***************************************************** 

Viewing and arranging files and folders in Win 7 
  

Just as in previous version of Windows OS, you can use small or large icons, list only 

names or list details of each file. 

Each time you click the left side of the VIEW button on the menu bar it cycles through 5 

different views, a) Large icons b) List  c) Details and d) Content.  IF you click the arrow on 

the right side of the VIEW button you'll have more options. 
  

*********************************************** 

Finding files in Win 7 
  

At the top of every window is a Search box.  Use this box to locate any file.  Just open the 

box and start typing info about the file.  

*************************************************** 

Copying and moving files and folders in Win 7 



  

1. Open the folder where the file or folder that you wish to move is located. 

2. Open the folder where you wish to place the file in a second window . 

3. Place these windows on the desktop so they are side by side. 

4. Now drag the file or folder from the first folder over to the folder in the second window. 

********************************************************** 

Deleting Files in Win 7 
  

Open the Library or folder in which the file resides. 

Select the file and press Delete on the keyboard. The file will be sent to the recycle bin. 

**************************************************************** 

Opening Files in Win 7 
  

To open most files, simply doubleclick that file.  However, if this is a picture file and you 

wish to edit that picture, rightclick the file and select Open With to open it in a photo 

program.  Otherwise the picture will open but you won't be able to change it. 

 

******************************************************************************

************************* 

Classic Start for Win 8 

Classic Shell 

Version 3.6.5 – general release 

Classic Shell  adds some missing features to Windows Vista, Windows 7 and Windows 8 - like a 

classic start menu, start button, a toolbar for Windows Explorer and others. 
 

The latest version can be found on Source Forge: 

http://classicshell.sourceforge.net/ 
 

Report problems in the Classic Shell bug tracker: 

http://sourceforge.net/tracker/?group_id=290975&atid=1230788 

 

For answers to frequently asked questions look here: 

http://classicshell.sourceforge.net/faq.html 

Or use the forums to get help: 

Help: http://sourceforge.net/projects/classicshell/forums/forum/1049756 

Discussion: http://sourceforge.net/projects/classicshell/forums/forum/1049755 

 

Classic Start Menu 
 



Classic Start Menu is a clone of the start menu from Windows 2000, XP and Vista that sadly is 

gone missing in Windows 7. It has a variety of advanced features: 
 

•        Drag and drop to let you organize your applications 

•        Options to show Favorites, expand Control Panel, etc 

•        Shows recently used documents. The number of documents to display is customizable 

•        Translated in 35 languages, including Right-to-left support for Arabic and Hebrew 

•        Does not disable the original start menu in Windows. You can access it by Shift+Click on 

the start button 

•        Right-click on an item in the menu to delete, rename, sort, or perform other tasks 

•        The search box helps you find your programs without getting in the way of your 

keyboard shortcuts 

•        Supports jumplists for easy access to recent documents and common tasks 

•        Available for 32 and 64-bit operating systems 

•        Has support for skins, including additional 3rd party skins. Make your own! 

•        Fully customizable in both looks and functionality 

•        Support for Microsoft’s Active Accessibility 

•        Converts the “All Programs” button in the Windows menu into a cascading menu (Vista 

and Windows 7)  

•        Implements a customizable start button (Windows 7 and 8) 

•        Can show, search and launch Windows Store apps (Windows 8) 

Classic Explorer 
 

Classic Explorer is a plugin for Windows Explorer that: 
 

•        Adds a toolbar to Explorer for some common operations (Go to parent folder, Cut, 

Copy, Paste, Delete, Properties, Email). The toolbar is fully customizable 

•        Replaces the copy UI in Vista and Windows 7 with the more user-friendly “classic” 

version similar to Windows XP 

•        Handles Alt+Enter in the folder panel of Windows Explorer and shows the properties of 

the selected folder 

•        Has options for customizing the folder panel to look more like the Windows XP version 

or to not fade the expand buttons 

•        Can show the free disk space and the total size of the selected files in the status bar 

•        Can disable the breadcrumbs in the address bar 

•        Fixes a long list of features that are broken in Windows 7 – missing icon overlay for 

shared folders, the jumping folders in the navigation pane, missing sorting headers in list 

view, and more 

Classic IE9 



 

Classic IE9 is a plugin for Internet Explorer 9 and 10 that: 
 

•        Adds a caption to the title bar so you can see the full title of the page 

•        Shows the security zone in the status bar 

•        Shows the loading progress in the status bar 

Installation instructions 
 

The toolbar for Windows Explorer will not show up automatically after installation. You have to 

do a few things before you can use it: 
 

1)      Open a new Windows Explorer window (Win key+E) 

2)      Go to the View menu and select Toolbars -> “Classic Explorer Bar” to show the toolbar. 

3)      If that option is not available (you only see “Lock the Toolbars”) you may have to enable 

the plugin from Internet Explorer. Run IE, right click on its toolbar and select “Classic 

Explorer Bar”. It will ask you if you want to enable this add-on. Select “Enable”, then do 

steps 1 and 2 again. 

4)      If that doesn’t work, try going to Tools -> Manage addons in Internet Explorer. Locate 

the addons “Classic Explorer Bar” and “ExplorerBHO Class” and make sure they are 

enabled. 

5)      If even then you don't see the toolbar, maybe the browser extensions are disabled on 

your system. This is usually the default for servers. Open the "Internet Options", go to 

the "Advanced" tab, and check the option "Enable third-party browser extensions". 
 

It goes without saying (but I’ll say it anyway!) that you have to turn on the status bar from the 

View menu if you want to see the file sizes. 
 

The caption in Internet Explorer may not show up automatically after installation. You may get 

a prompt to enable the ClassicIE9BHO plugin. If you get the prompt, select “Enable”. If you 

don’t get a prompt, go to Tools -> Manage addons and make sure the addon “ClassicIE9BHO” is 

enabled. After that restart Internet Explorer. 

Uninstallation 
 

To uninstall Classic Shell follow these steps: 

1)      Open a new Windows Explorer window 

2)      Make sure the toolbar is hidden (if you uninstall while the toolbar is visible, the menu 

bar in Explorer will get stuck in the visible state and you won’t be able to hide it) 

3)      Close all Windows Explorer windows 

4)      Open Control Panel -> Programs and Features and double-click on Classic Shell. Then 

follow the instructions. You may have to restart Windows to complete the process. 



5)      If you installed any additional skins for the start menu you will have to delete them 

manually 

 

If you missed step 2 and now you can’t hide the menu bar in Explorer, install Classic Shell 

again, and follow the uninstall steps carefully. 

If you upgrade from version 2.8.3 or older 
 

The new settings system will not preserve any of your old settings. Neither the ones done in the 

Settings dialog, nor the ones in the ini files. 

The new system is designed to be forward-compatible, so any future version will be able to 

preserve your settings during upgrade. 
 

******************************************************************************

**************** 

Computer Slow Down 

 
IF your computer has slowed down....do a really good monthly maintenance and see if it picks up speed. 
Usually a slow down is due to one of two things,  
1. Too many files that need to be deleted such as temporary internet files, temp files, history files, old 
email files,etc...even old System Restore Points. 
2. A program that's been installed that is a resource(RAM) guzzler. 
  
  
Doubleclick My Computer and rightclick the C: drive. 
1. Click Disk Cleanup to take care of #1 above 
2. Then click Tools and click Error checking. You'll need to restart your computer to do this and it will take 
quite a bit of time if you have a large hard drive...so let it run while you're doing something else.   
Click Error checking and restart your computer to allow it to do the program. 
2. Next do defrag. 
3. If no difference in speed after doing the above, check for that “program”. 
 a. Click Start…Run and type in msconfig   then click OK 
 b. Click the LOAD THESE ITEMS AT STARTUP to remove the check. 
 c. Click Apply and Ok and restart your computer….if it is speedier now, you can be pretty sure the 
problem is a particular program that is starting each time you start your computer. Problem is, it isn’t quick 
and easy to isolate the problem.  So, do this when you have several hours to spare. (if you can’t do it 
now, go back to msconfig and put the check back into Load these Items…..) click Apply and Ok and 
restart as you MUST have your anti-virus program and firewall and spyware programs running if you plan 
to get online at all. 
  
4. Isolate problem program: 
 a. Click Start…Run and type in msconfig  then click OK 
 b. Place a check in SELECTIVE  rather than Normal 
 c. Click the Startup tab. 
 d. Uncheck half the boxes. Make a note the last box unchecked so you’ll know where to start 
next.  Click Apply and Ok and restart your computer. Is it speedier?  IF yes, then you know the program is 
one of those you unchecked. Go back and check back half of those unchecked and see if it’s still 
speedier.  IF yes, you know it’s one of those boxes still unchecked. 
 e. You must continue unchecking and checking boxes until you find the particular program box 
that causes the slow-down. Once that is determined, you must decide if you can do without that program 
being in STARTUP or even if you can uninstall that program entirely. 



 
Items that Must be in Startup: 
Anti-virus program 
Anti-spyware program 
Firewall, if using a firewall 
Snynotic Mouse, if you're using the built in mouse on a laptop 
Any other program that if it is not in startup causes problems in running your computer. You will know this 
when you restart and begin using the computer if you get an error message relating to a particular 
program that it is looking for that has been unchecked in Startup. 
 
******************************************************************************* 
 
Another possible way to find the slowdown culprit 
 
Assuming you’re running Windows XP: 
1. Rightclick the taskbar at the bottom of your screen, and select Task Manager 

2. The task manager has 5 tabs: Application, Processes, Performance, Networking and Users. 

Click the Processes tab. It has 4 columns. Image Name, User Name, CPU and Mem Usage. Each 

column can be sorted ascending or descending by clicking the column title. 

3. Open the task manager, select Processes and the CPU column until you experience one of 

these slowdowns. Sort by the CPU column and note which image name which is using most of 

the CPU processing.  

4. Click that image name and select END PROCESS. 

5. Now, go to www.google.com and enter the image name of the process to learn which program 

it is associated with. 

6. Remove this program from your STARTUP to prevent it from starting every time you start 

your computer.  

NOTE: if it is your anti-virus or firewall, you may consider changing the settings, but you do not 

want to remove these two programs from STARTUP.  Might be better to consider using a 

program that is less hoggish in it’s demands on your processor.  

Note: System Idle Process is not a bad process, don't try and remove this process. 

******************************************************************************************** 

 
  

 

  
  

Pork Chops in Savory Mushroom Cream Sauce 
 
4 boneless pork loin chops (1/2 inch thick)  
1/2 teaspoon seasoned salt  
1/2 teaspoon pepper  
... 4 teaspoons canola or olive oil  
1 medium onion, cut into thin wedges  
1 package sliced fresh mushrooms (2 cups)  
1/2 cup Progresso® chicken broth (from 32-oz carton)  
4 teaspoons cornstarch  



1 container (6 oz) Yoplait® Greek Fat Free plain yogurt  
4 cups hot cooked rice or pasta  
 
Sprinkle both sides of pork chops with seasoned salt and pepper. Heat 2 teaspoons of 
the oil in 10-inch nonstick skillet over medium-high heat until hot. Add pork chops; cook 
about 4 minutes on each side or until golden brown. Remove pork chops from skillet; 
set aside. 
 
In same skillet, heat remaining 2 teaspoons oil over medium heat. Add onion and 
mushrooms; cook 3 minutes, stirring frequently. 
 
In measuring cup, mix chicken broth and cornstarch; add to skillet. Heat to boiling. 
Return pork chops to skillet; spoon some of the sauce over pork. Reduce heat; cover 
and simmer for about 30 minutes, stirring occasionally, until pork is no longer pink in 
center.  
 
Stir in yogurt until well blended; cook over low heat just until heated through. Serve with 
rice or pasta. 
 
http://www.pillsbury.com/recipes/pork-chops-in-savory-mushroom-cream-
sauce/e9ed3498-3de2-473a-92b1-24b51ca3ffa4See More 
  
  
*************************************************************************** 

This  just hit me! 
My dog sleeps about 20 hours a day. 
He has his food prepared for him. 
His meals are provided at no cost to him. 
He visits the Dr. once a year for his checkup, and again during the year, if any 
medical needs arise. 
For this he pays nothing, and nothing is required of him. 
He lives in a nice neighborhood in a house that is much larger than he needs, but 
he is not required to do any upkeep. 
If he makes a mess, someone else cleans it up. 
He has his choice of luxurious places to sleep. 
He receives these accommodations absolutely free. 
He is living like a king, and has absolutely no expenses whatsoever. 
All of his costs are picked up by others who earn a living.  
I was just thinking about all this and suddenly it hit me like a ton of bricks ~  
My dog is a CONGRESSMAN! 
************************************************************************* 

Putin's speech on 

Feb.04, 2013  

 



This is one time I would recommend to our elected leaders, that they pay attention 

to the advice of Vladimir Putin....how scary is that? 

 

On February 4th, 2013, Vladimir Putin, the Russian president, addressed the Duma, 

(Russian Parliament), and gave a speech about the tensions with minorities in 

Russia :  

"In Russia live Russians. Any minority, from anywhere, if it wants to live in Russia , 

to work and eat in Russia , should speak Russian, and should respect the Russian 

laws. If they prefer Sharia Law, then we advise them to go to those places where 

that's the state law. Russia does not need minorities. Minorities need Russia , and 

we will not grant them special privileges, or try to change our laws to fit their 

desires, no matter how loud they yell 'discrimination'. We better learn from the 

suicides of America , England , Holland and France , if we are to survive as a nation. 

The Russian customs and traditions are not compatible with the lack of culture or 

the primitive ways of most minorities. When this honorable legislative body thinks 

of creating new laws, it should have in mind the national interest first, observing 

that the minorities are not Russians.  
 

The politicians in the Duma gave Putin a standing ovation for five minutes. 
******************************************************************************* 

JmaxJmaxJmaxJmax  

Jmax's Website   http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  



 


